ADAPT-PT/RC 2018

Getting Started Tutorial

ADAPT-RC mode

Update:

September 2018

Copyright © ADAPT Corporation all rights reserved
This ADAPT-PT/RC 2018 Getting Started Tutorial is intended to be used as a practical example and guide for modeling a 2D post-tensioned two-way slab frame in the RC mode of the program. While the example is related to a specific system type (two-way slab) the workflow applies to input of one-way slabs and beams. For additional information, refer to the **ADAPT-PT/RC 2018 Getting Started Tutorial for PT mode** and the **ADAPT-PT/RC 2018 User Manual**. Both documents can be accessed from the HELP menu of the program.

The example model is created with the help of a wizard which consists of different *Input Forms*. Each *Input Form* can be accessed at any time through the *Menu Bar*. The input that you provide on the *Input Forms* is displayed real-time in the *Structure View*. The view of the structure can be modified with the help of the *View Toolbar* which contains *View Tools* with which you can change the perspective, turn on and off components and zoom. The *Main Toolbar* contains *Common Tools* such as *New Project*, *Open Project* and *Save Project*.

**FIGURE 1: ADAPT-RC User Interface**
 COLUMN-SUPPORTED SLAB (TWO-WAY SYSTEM)

The objective of this tutorial is to explain how a floor strip or frame line is idealized from a complete floor system and modeled as a slab- or beam-frame ADAPT-PT/RC 2018. This tutorial will demonstrate the step-by-step procedure in the RC mode of ADAPT-PT/RC to generate data, analyze and design a column-supported slab which is a part of a floor system. A column-supported slab is generally considered as a conventionally reinforced two-way system. The tutorial covers the following features of the program:

- Generation of input data, using the simple “Conventional” option of the program.
- Review of program calculated results and reports, both tabular and graphical.

The structure selected is a typical design strip from a floor system. The geometry, material, loading and other particulars of the structure are given below. The geometry of the whole floor is shown in Figure 1-1. The design strip for this tutorial is shown hatched in Figure 1-2.

![FIGURE 1-1]
FIGURE 1-2

The lengths and tributary widths of the spans of the design strip in orthogonal direction are shown in Figure 1-3.
The elevation of the design strip is shown in Figure 1-4.

![Figure 1-4](image)

**FIGURE 1-4**

The length of the spans of the design strip along support line 2 is shown in Figure 1-5.

![Figure 1-5](image)

**FIGURE 1-5**

The idealized design strip is shown in Figure 1-6.

![Figure 1-6](image)
MATERIAL PROPERTIES AND LOADING

Thickness of slab = 10 inch

(i) Material Properties

○ Concrete:
  Compressive strength, \( f'_c \) = 4000 psi
  Weight = 150 pcf
  Modulus of Elasticity = 3605 psi

○ Nonprestressed Reinforcement:
  Yield stress, \( f_y \) = 60 ksi
  Modulus of Elasticity = 29000 ksi
  Minimum Rebar Cover = 1 inch Top and Bottom

(ii) Loading

  Superimposed Dead load = 30 psf (uniform)
  Live load = 50 psf (uniform)
1.1 GENERATE THE STRUCTURAL MODEL

When the program is launched from the desktop shortcut or from the computer START menu, the opening screen will appear as below. This screen gives you the option to select a design mode of **Post-Tensioned or Mild Reinforced**. For this tutorial, select the **Post-Tensioned** option and **OK**. This will open the PT mode of the program where the PT input forms are active and loaded.

In the ADAPT-RC 2018 input screen, click the *Options* menu and set the *Default Code* as **American-ACI318 (2014) / IBC 2015** and *Default Units* as **American**.

1.1.1 Edit the Project Information

1.1.1.1 General Settings

Open the new project by clicking either **New** on the *File* menu or the **New Project** button on the toolbar. This automatically opens the *General Settings* input screen, as in **Figure 1.1-1**. You can enter the *General Title* and /or *Specific Title* of the project in that window. For the purpose of this tutorial, enter the *General Title* as **Support Line 2**. This will appear at the top of the first page of the output. Enter *Specific Title* as **Two Way Slab**. This will appear at the top of each subsequent page of the output.
Next, select _Geometry Input_ as **Conventional**.

Next, select the _Structural System_ as **Two-Way slab**. Then there is an option to include drop caps, transverse beam and/or drop panels. In this case select **No**. Select **No** for the option _Recommend Slab Thickness_.

Click **Next** at the bottom right of this screen to open the next input screen, _Design Settings_.

**FIGURE 1.1-1**

### 1.1.1.2 Design Code

In the Design Code screen, set the code as **American-ACI318 (2014) / IBC 2015**.

**FIGURE 1.1-2**
1.1.1.3 **Design Settings**

This screen is divided into three parts: *Analysis options*, *Design options*, and *Contribution to unbalanced moment*.

In *Analysis options*, you can select various calculation settings.

First, select **Yes** for *Reduce Moments to Face-of-Support* option.

Select **No** for the option to *Redistribute moments*.

Select **Yes** for the Equivalent Frame Modeling.

In *Design options*, check *Use all provisions of the code* that you have selected in the previous step.

In *Generate moment capacity based on*, check *Design Values*.

In *Contribution to unbalanced moment*, leave the contribution of *Top isolated bars* and *Bottom isolated bars* as default values (100 percent).

Click **Next** at the bottom right of the *Design Settings* screen to open the *Span Geometry* input screen.
1.1.2 Edit the Geometry of the Structure

1.1.2.1 Enter Span Geometry (Figure 1.1-4)

This screen is used to enter the cross-sectional geometry of the slab as per Figure 1-6.

Set the *Number of Spans* as 4 either by clicking the **up arrow** or using **CTRL +**.

Select the section, *Sec*, as **Rectangular** and edit *29.20 ft* for length, *L*, *310.00 in* for width, *b*, and *10 in* for height, *h*, for SPAN 1. Similarly enter details for SPAN 2, 3, 4 and R-Cant as shown in Figure 1.1-5. The widths (*b*) of each span are average tributary width for that span.

As you enter the values, the span is displayed in real-time in the 3D window.

The reference height (*Rh*) identifies the position of a reference line that is used to specify the location of the tendon. Typically, the reference height is set equal to the slab depth. Edit reference height, *Rh* as **10 in**, i.e., slab depth, for all spans.

The left and right multiplier columns (<-M and M->) are used to specify the tributary width to indicate how much of the tributary falls on either side of the support line. For this tutorial, tributary method is used, i.e., tributary widths are entered as width, *b*, and the ratio of the tributary width on either side of the support line is entered as the left and right multipliers. For SPAN 1, enter <-M and M-> as **0.47** and **0.53** respectively. Similarly enter details for SPAN 2, 3, 4 and R-Cant as shown in Figure 1.1-5.
FIGURE 1.1-5

Click Next on the bottom line to open the next input screen.

1.1.2.2 Enter Support Geometry

This screen is used to input column/wall heights, widths and depths. You may enter dimensions for columns/walls above and/or below the slab.

Select the Both Columns from the support selection. Enter 9.02 ft for $H_1$ and 9.84 ft for $H_2$ in the typical row and press ENTER, since all the supports are the same height.

Next, enter the dimensions of the supports. B is the dimension of the column/wall cross-section normal to the direction of the frame. D is the column/wall dimension parallel to the frame.

Enter the given column/wall dimensions as in Figure 1.1-6.

On this input screen, you can select for each support whether the left edge and the right edge of that support is interior or exterior.

In this case, all supports are interior as the span is an interior span.
Click **Next** on the bottom line to open the *Supports Boundary Conditions* input screen.

### 1.1.2.3 Enter Support Boundary Conditions

This screen is used to enter support widths and column boundary conditions.

Support widths can be entered if you answered “Yes” to the “Reduce Moments to face-of-support” question on the *Design Settings* screen, i.e., if you answered “No”, you cannot input values in the *SW* column. This input value will be used to calculate the reduced moments.

Since the support width, *SW*, is set to the column/wall dimension (D) as a default, the SW values will be automatically determined from the support geometry and cannot be modified by the user. If you want to input the *SW* values, **uncheck** the *SW=Column Dimension* box.

Select the boundary conditions for lower and upper columns as **1 (fixed)** from the drop down list.

Leave the *End Support Fixity* for both the left and right supports as default **No**. This will be used when the slab or beam is attached to a stiff member.
FIGURE 1.1-7

Click Next at the bottom of the screen to open the input screen Loading.

1.1.3  Enter Data

1.1.3.1  Edit the Loading Information

Enter the span number as 1 in the Span column. If the loads are the same for all the spans, you can type ALL or all in the Span column. This will copy the data to all of the spans.

If you choose not to include Self-weight, you now have the option to define the self-weight (SW) as a Class. In any case, you can choose to specify additional dead load as superimposed dead load (SDL) as a Class.

PT/RC 2014 gives you the option to specify any load as an X Class.

Select the Class as SDL from the drop down list and specify the load type as uniform either by typing U in L-? or by dragging the icon from the graphics of the uniform loading.

The default of the load type when you select the load class is L-U; so leave it as is for this tutorial.

Type 0.03 k/ft² (=30 psf) for superimposed dead load in the w column. You can enter DL with or without self-weight, since the program can calculate self-weight automatically. In order to calculate the self-weight automatically, you must answer Yes to Include Self-Weight question at the top right of the screen and enter 150 pcf as unit weight of concrete.

Repeat the procedure for live load by entering the span number and changing the Class to LL and w value to 0.05 k/ft² (=50 psf) for all spans.
Answer **Yes** to *Skip Live Load*? at the top left of the screen and enter the *Skip Factor* as 1 (**Figure 1.1-8**).

![FIGURE 1.1-8](image1.png)

If you go to any other form and navigate back to the Loads input form, you will see that the loading information is now entered in the table for each span (**Figure 1.1-9**).

![FIGURE 1.1-9](image2.png)

Click **Next** at the bottom of the screen to open the *Material - Concrete* input screen.
1.1.4 Edit the Material Properties

1.1.4.1 Enter the Properties of Concrete

Select Cylinder concrete strength at 28 days. Select the Normal weight and enter the strength at 28 days for slab/beam and column as 4000 psi. When you press Enter from the strength input value, the Modulus of Elasticity will be calculated automatically based on the concrete strength and the appropriate code formula.

For this tutorial, keep the value of creep coefficient as 2. The creep coefficient will be used in the calculation of long-term deflection. Consider

![Image of Material - Concrete dialog box](image)

**FIGURE 1.1-10**

1.1.4.2 Enter the Properties of Reinforcement

In the section Longitudinal reinforcement, change the values for Yield Strength and Modulus of Elasticity to 60 ksi and 29000 ksi respectively. Change the Preferred Bar Sizes for Top and Bottom to 5 and 8 respectively. These will be used when calculating the number of bars required.

In the section Column Strip Allocation, specify 60%, 70% and 100% for In spans, Over interior columns and Over exterior columns, respectively. This section specifies allocation of reinforcement in column strip and middle strip. Note the balance of 100% is applied to middle strip reinforcement. Refer to ACI 318 Chapter 13 for applicable distribution percentages for column strips.
In Shear reinforcement, select *Stud (headed bar)* and change *Preferred Stud diameter*, *Yield strength shear reinforcement* and the *Number of rails per side* to **0.5 inch, 60 ksi** and **2** respectively.

![Material - Reinforcement](image)

**FIGURE 1.1-11**

Click **Next** at the bottom of the screen to open the next input screen.

### 1.1.4.3 Edit Base Reinforcement

The program allows you to specify a base reinforcement that is taken into consideration when designing the structure. Select **Yes** in the *Base Reinforcement* section.

You have the choice between defining a mesh or isolated rebar. For this example choose **Isolated** from the drop down box.

Next specify the span where your base reinforcement starts. For this example, let the rebar start at the beginning of span 1. Therefore, enter a **1** in *First end location* and a **0** in *X1/L*.

If you want to specify the end of the reinforcement at the end of span number 4, define **4** for *Second end location* and **1** for *X2/L*.

Furthermore, you specify **4** bars (*Number*) with *Bar Size* of **6** as **Bottom** bars with a *Cover* of **2 inch**.
Click Next at the bottom of the screen to open the input screen, *Criteria – Allowable Stresses*.

1.1.5 **Edit the design criteria**

1.1.5.1 **Specify Minimum Covers for Mild Steel Reinforcement**

For nonprestressed reinforcement, edit **1.0 in** *Cover* for top, bottom and side (as shown in Figure 1.1-14).

Click Next at the bottom of the screen to open the input screen, *Criteria – Minimum Bar Extension*. 
1.1.5.2 Specify Minimum Bar Length and Bar Extension of Mild Steel Reinforcement

Use the default values for bar extensions (as shown in Figure 1.1-19). Note that the “development length” is user-defined and is the bar extension beyond point of zero moment where reinforcement is no longer required.

![Criteria - Minimum Bar Extension](image)

Click Next at the bottom of the screen to open the input screen, Criteria – Rebar Curtailment.

1.1.5.3 Specify Top and Bottom Rebar Curtailment Input for Spans

The default values given for Long and Short Bars relative for length equal to fraction of span and % of area of required steel are according to Chapter 13 of ACI-318 (2014). Keep the default values (as shown in Figure 1.1-20 and Figure 1.1-21). Note that curtailment rules relative to the selected code are applied to top and bottom bars and are conservatively adjusted such that the bar lengths are equal on both sides of the support or equal at both sides of the center of span. Also, 2 bars are set as a minimum requirement.

The reinforcement result output for this example will be based on the curtailment rules which take priority over reinforcement rules relative to the previous section for bar extensions. In the case where curtailment rules are not sufficient to the default solution (that solution related to the bar extension input) the reinforcement arrangement and length output will be given as that taken from the bar extension input.
FIGURE 1.1-20

---

Criteria - Reinforcement Curtailment

### Description

<table>
<thead>
<tr>
<th>Top Bars</th>
<th>Bottom Bars</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACI 318 Curtailment, Two-Way Slab, Top Bars.</td>
<td>ACI 318 Curtailment, Two-Way Slab, Bottom Bars.</td>
</tr>
</tbody>
</table>

#### Top Bars

<table>
<thead>
<tr>
<th>Comp. Bar</th>
<th>Ext. Span</th>
<th>Int. Span</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>0.3</td>
<td>0.3</td>
</tr>
<tr>
<td>L</td>
<td>0.5</td>
<td>0.5</td>
</tr>
<tr>
<td>min bars</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

#### Bottom Bars

<table>
<thead>
<tr>
<th>Comp. Bar</th>
<th>Ext. Span</th>
<th>Int. Span</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>0.2</td>
<td>0.2</td>
</tr>
<tr>
<td>L</td>
<td>0.5</td>
<td>0.5</td>
</tr>
<tr>
<td>min bars</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Note: Top bar extensions represent lengths measured from supports.

---

FIGURE 1.1-2

---

Criteria - Reinforcement Curtailment

### Description

<table>
<thead>
<tr>
<th>Top Bars</th>
<th>Bottom Bars</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACI 318 Curtailment, Two-Way Slab, Top Bars.</td>
<td>ACI 318 Curtailment, Two-Way Slab, Bottom Bars.</td>
</tr>
</tbody>
</table>

#### Top Bars

<table>
<thead>
<tr>
<th>Comp. Bar</th>
<th>Ext. Span</th>
<th>Int. Span</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>0.3</td>
<td>0.3</td>
</tr>
<tr>
<td>L</td>
<td>0.5</td>
<td>0.5</td>
</tr>
<tr>
<td>min bars</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

#### Bottom Bars

<table>
<thead>
<tr>
<th>Comp. Bar</th>
<th>Ext. Span</th>
<th>Int. Span</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>0.2</td>
<td>0.2</td>
</tr>
<tr>
<td>L</td>
<td>0.5</td>
<td>0.5</td>
</tr>
<tr>
<td>min bars</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Note: Bottom bar extensions represent gaps measured from supports.
1.1.5.4 Input Load Combinations

**Figure 1.1-16** shows the screen which is used to input the load combination factors for strength (ultimate) load conditions. It is also used to enter any applicable strength reduction factors. The default values are according to the American-ACI318 (2014) / IBC 2015.

The program allows you to specify four strength and service load combinations. For ACI318 (2014) / IBC 2015. The program automatically determines service (minimum) reinforcement per the code selected and system type. For this example, do not include lateral loads.

![Figure 1.1-16](image)

**FIGURE 1.1-20**

1.2 SAVE AND EXECUTE THE INPUT DATA

To save the input data and execute the analysis, either select **Execute Analysis** on the menu bar or click on the **Save & Execute Analysis** button. Then, give a **file name** and **directory** in which to save the file. Once the file is saved, the program will automatically execute the analysis by reading the data files and performing a number of preliminary data checks.

Once successfully finished, you return to the main program window. The Results can be viewed and/or printed as Reports, Graphs and PT Summary as shown in **Figure 1.2-1**.
1.3 CREATE REPORTS

ADAPT-PT/RC 2017 includes the Report Generator. To setup the report, select the Report Setup item on the Options menu or click the Report Setup button on the main toolbar. The Report Generator screen shown in Figure 1.3-1 will open.

The program allows you to generate reports in an MS-Word® editable format. You have the following options:

- Report cover: Select this option to generate a report cover with your logo and company information. To update your company information, click on Update Company Info on the Report Generator and you will see the screen Company Information shown in Figure 1.3-2.

- Table of Contents


- Tabular Reports – Compact

- Tabular Reports – Detailed

- Graphical Reports

Close the above window by clicking X at the top right corner.
• Legend

**FIGURE 1.3-1**

Simply check any item in the *List of all Sections* to include it in the report. The item will then appear in the *List of Selected Sections* on the right hand side of the *Report Generator*.

To generate and view the report, click on **Generate/View Report** on the bottom of the *Report Generator*.

The program allows you to open and view existing reports by clicking on **Open Reports**.

The Report Generator allows you to save report content as either a default template or as a user defined template. This enables you to quickly select content for any project by either using the default content or any other user defined content.

To define content as the default template, select report content from the *List of all Sections* and click on **Save as Default**.

To define content as a user defined template, select report content from the *List of all Sections* and click on Save Selection. You are asked to enter a name for your selection. This name appears then in the drop down box in the **User Selections** frame.
To open the “RC Summary Report” (Figure 1.3-3) either click the **BuilderSum** button on the tool bar or select the **RC summary** item on the View menu.
FIGURE 1.3-3

To view the graphs, either click the **Show Graphs** button from the toolbar or select **Graphs** in the menu.
**Forces Diagram** button displays forces for selected load combinations or envelop as shown in Figure 1.3-4.

**FIGURE 1.3-4**

**Moment Diagram** button displays forces for selected load combinations or envelop as shown in Figure 1.3-5.
**FIGURE 1.3-5**

*Rebar Diagram* button displays forces for selected load combinations or envelop as shown in *Figure 1.3-6*.

**FIGURE 1.3-6**

Additional references to be consulted with this manual:

2. ADAPT-PT/RC 2018 Getting Started Tutorial – PT mode